
1 

3 

4

5 

6

 7

 8

This Issue: 

Message from the 
President 

Chapter Luncheon 

Chapter Member 
News

FM Article

Treasurer Report/
Chapter Calendar 

Computer Tips & 
Tricks 

Execu ve Board 
Mee ng Minutes 

ASMC Na onal 
News 

Execu ve Board 
Roster 

Greetings Aviation Chapter Members!

April was a big month for our chapter – we hosted, with HQ AFMC FM, our very first 
virtual Mini-PDI: “Hindsight is 20/20: From Challenges to Change”!  We’ve all had to 
adapt and overcome with the challenges and changes we’ve faced in the last year or so, and 
doing most things virtual is one of those ways that we have adapted.  I hope that the virtual 
platform, and separating it into two half-days, allowed personnel to attend who may not be 
able to take a full day “out of the office.”   

We had a great lineup of speakers – the first day Brig Gen Greiner kicked off the event 
with some opening remarks on how we are operating in the current environment and 
continuing to support the mission.  Next, Mr. Ed Fritts provided some great excel tips, 
along with resources for everyone to go check out later.  Then Ms. Beer and Mr. Baker 
provided insight into DEAMS, and Col Hamblin showed us how a lot of changes have 
taken place and the importance of being able to take risks.

And then on the second day, Col Brian Kehl enlightened us about Space Operations; Mr. 
Carlos Rodgers provided superb training on government civilian interview preparation; and 
Mr. Chip Fulghum followed up with some great points about what makes an effective 
leader.  While the first day’s speakers were mostly local to Wright-Patt, on the second day, 
all of the presentations were from various states across the country…and time zones!  So 
that is one great benefit to having a virtual Mini-PDI, that we were able to enjoy 
presentations from speakers across the Department of the Air Force and beyond.     

It was a great honor to be able to present our Aviation Chapter Awards, as well as 
recognizing our personnel who won awards at the National level.  As I mentioned during 
the Mini-PDI, the number of National Awards that our FMers receive shows the high-
caliber personnel we have here at Wright-Patt.  Between last year and this year, we had 15 
National Award winners from among all the Services in the DoD!

We had a great turnout for the Mini-PDI, and I hope everyone enjoyed the presentations by 
our wonderful speakers.  If you attended, please be on the lookout for our survey to 
provide feedback, and your certificate within a couple weeks.  

Twitter: @asmctweets
Facebook: www.facebook/pages/American-Society-of-Military-Comptrollers 
Website: http://www.asmc-aviation.org/

Chapter President  

Sheena Fast 
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Talking about the Mini-PDI would not be complete without a big THANK YOU to everyone for attending, our speakers with 
their outstanding presentations, and, of course, the TEAM that made it all possible!  

Don’t forget – there are still more opportunities for continuing education through National’s virtual PDI (2020 and 2021) and 
TekSouth’s monthly Tips and Tricks.  See more information regarding each of these opportunities below. 

We’ve all heard the saying “many hands make light work” – well, we need more hands to help out with our chapter!  The 
Chapter is still looking for volunteers for a few open positions, to include Secretary, Professional Development Chair, 
Awards Chair, Community Actions Chair, and Ways and Means Chair.  Additionally, we have several Vice-President 
positions up for election, with the 2-year term starting in July: AFLCMC, AFAA, and Contractors.  We also have 1-year 
terms for the HQ AFMC and 88 CPTS VP positions.  Please contact me or your organizational VP if you’d like to volunteer 
or have any questions about any of the positions.  This is a great opportunity to get involved with our organization!  See 
below for the responsibilities of each of these positions/committees.
• Secretary – records minutes for Chapter and Board meetings; maintains the records for the Chapter; and is
responsible for distribution of official mail, as needed.

• Professional Development Committee – establishes education and training goals for the Chapter; plans, coordinates,
and arranges any seminars, training sessions or classes conducted by the Chapter; and accomplishes other educational
activities as directed by the Executive Board to include mini-PDIs.

• Awards Committee – informs financial management community of awards programs, collects nominations for local
and national submission, manages the review of nominations for local awards, and acquires/distributes the plaques for local
award winners.

• Community Actions Committee – organizes volunteer activities.

• Ways and Means Committee – organizes fundraising activities.

• Vice President – serves as liaison point for the Chapter with their respective organization, providing communication
on all Chapter events.

See below for some additional national ASMC news:

*National has announced that the ASMC National PDI 2021 will be virtual only, to be held 2-4 June 2021, with the theme
“Adapt, Evolve, and Transform: At All Times Ready!”

*The ASMC National Virtual PDI 2020, with 28.5 CPEs, is offered at no cost to ASMC members.  Go to https://
asmconline.org/pd/virtual-pdi/ to register (make sure your membership is up-to-date first!).  FREE CPE!!

*The May Tips and Tricks provided by TekSouth will be on 20 May 2021 at 1000 (EST) or 1500 (EST) (one hour).  This
month’s session will demonstrate some data management secrets that you don’t want to miss.  The session will show you
how you can adjust any set of data from current systems such as GFEBS (Army), DEAMS (Air Force), and SMARTS (Navy
and Marines).  The full synopsis for the session can be found on the registration page.  You can register at https://
www.teksouth.com/vtt-reg/.

*Don’t forget to renew your membership!!  National is having a monthly drawing for members who renew on-time or early –
so remember to check when your membership expires. Congratulations to Kevin Gould for winning the March drawing!

Sheena Fast
President, Aviation Chapter 
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MONTHLY MEMBER MEETING 

Upcoming Member Meetings: 

May 27 - Speaker: Ms. Angela Ruter
Topic: “Briefing the Boss”

April Member Meeting - ASMC Aviation Chapter Mini Professional Development 
Institute (PDI), 28-29 April 2021

On 28-29 Apr, ASMC Aviation Chapter presented two half-day virtual Mini PDI sessions.  Our Master 
of Ceremonies for this year's Mini PDI was Mr. Broc Begley.  The invocation was provided by Chaplain 
Lt Col Steven Barfield.  Opening remarks were presented by Brig Gen Greiner, Comptroller, HQ 
AFMC/FM.  The first day presenters were:

• Mr. Ed Fritts,Teksouth, Excel Tips and Tricks
• Ms. Jeannette Beer, Director, AFAOC, SAF/FMFSO, AFAOC Update, and Mr. Todd Baker,

Director, DEAMS, DEAMS Development Update
• Col Jeffrey Hamblin, Director, Special Programs Division, AFLCMC, Hindsight is 2020:  from

Challenges to Change

The second day sessions presenters were:

• Col Brian Kehl, Director, Plans, Programs, and Financial Management, HQ Space Operations
Command, Space Operations Command, Adapting to an Evolving Environment

• Mr. Carlos Rodgers, SES, SAF/FMB, Government Civilian Interview Preparation
• Mr. Chip Fulghum, Chief Operating Officer, Endeavors, Three Legged Stool of Leadership

The full agenda can be found at https://www.asmc-aviation.org
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Small Team Achievement
Contracting Officer’s Representatives 

(COR)
Centrally Directed Audit Team

Elaine “Daisy” Bradley
Rebecca Long

Dieane Crawford
Teresa Schutter

Large Team Achievement
SBRF Financial Management Team

Team Lead:  Sarah French 

Kristen Wentworth
Natalie Klement
Dustin Test
Jacquelyn Waggamon
Nathan Johnson
Kenzie Kush
Amber Smith
Candice Lock
Stephanie Robinson

Tammy LeMaster
Barbara Hager
Jennifer Robinson
Gregory Collins
Brooke Brown
Andrew Granato
Alison Gahris
Philip BullMaster
Jacquelyn Suhr
Christopher Dillon

Calendar Year 2020 ASMC Aviation Chapter Achievement  Awards 
and National Award Winners
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New and Improved AFAOC Monthly Users Forum on milBook
Mr. Charles Edson, Chief, AFAOC Customer Support Division

 The AF Accounting Operations Center (AFAOC) has evolved its Monthly Users Forum to a virtual forum presented in the 
DEAMS Users Group on milBook (https://www.milsuite.mil/book/groups/deams/blog). This change was initiated by 
customer feedback, which expressed the desire for increased user engagement, flexible scheduling, and enhanced support 
for remote operations. We are excited for the opportunity to provide useful, relevant information while maximizing your 
time, interest, and attention.

As of February 2021, Users Forum content began being published to the DEAMS Users Group and will continue to be 
available by the third week of every month to provide information for users’ independent review at their own pace and on 
their own schedule. As users review the materials, they can post questions to be answered by content Subject Matter 
Experts (SMEs), who will continuously monitor the site to address questions and facilitate discussion.
DEAMS users can still expect the same valuable information as from previous Forums, just in a different format– no more 
hour-long briefings with limited time for user questions and discussion.  

Content will now be presented in one of three formats:

 Written in the form of narrative, blog posts
 Slides with Audio similar to how previous Users Forums were recorded and posted
 Video Walkthroughs step-by-step processes in the system with audio narration. This gives our experts the flexibility 

to present content in ways that clearly communicate the topic and benefit you

Additionally, to maintain our focus on collaboration and open discussion with users, Live Question and Answer (Q&A) 
sessions are conducted via DCS on the third Thursday of each month at 0900 and 1800 ET. These moderated Q&A sessions 
put users in direct contact with the experts who developed the training material. The live Q&A sessions are limited to 
discussion of the Users Forum materials, so please review the material before particpatng in these topic-specific calls. If 
you cannot attend the Q&A session, post your questions in the DEAMS Users Group, and our dedicated SMEs will provide a
timely response.

You can still earn CET credits! Review all of the current month’s Users Forum content and complete the online AFAOC 
Monthly Users Forum CET Request Form to earn one (1) CET credit.

Access the DEAMS Users Group on milBook at any time to familiarize yourself with the site and review all the great 
information provided. 



TREASURERS’ REPORT/CHAPTER CALENDAR 

TREASURER’S REPORT 

March 2021 

Treasurers:  Dawn O'Connell and Rebecca Workman 

Note:  
The Fidelity ending balances are 31 March 2021. The 
Fidelity account balances are investments and fluctuate 
with the market.  This causes unrealized gains and 
losses, which are captured in the Income.

Aviation Chapter Calendar 
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May 27, 2021 Speaker: Ms. Angela Ruter,“Briefing the Boss” - Virtual



COMPUTER TIPS and TRICKS by GEORGE DIEHL 

Email Rules in Outlook

Managing emails is a difficult task. A common estimate for daily emails a user sends and receives is over 100 emails. 
For many users, a cost of teleworking is an increased number of emails coming in and going out. Unfortunately, a large 
number of these emails are automated responses or informational that do not need immediate response. In some 
cases, an automated response would be sufficient for certain types of emails. 

Outlook Rules can be used to automate a variety of actions (e.g., move emails, flag emails, create custom 
customizations). For example, a user receives newsletters they like to read when they have time. A rule could be setup 
to take any incoming email with the newsletters’  sender and subject and move them to a specified folder. Now the 
newsletters will not clog up their Inbox and are easy for the user to locate when needed. 

Rules can be started from scratch by clicking on the Rules dropdown in the Home tab of the Ribbon and selecting 
Mange Rules and Alerts. Alternatively, a new rule can be started from a specific email by right-clicking on the email 
then going to Rules and choosing one of the options from there. Detailed examples and instructions can be found 
here. 

Outlook Tasks

For fans of to-do lists, Outlook allows users to create Tasks. These Tasks have a variety of options including options to 
setting a status, priority, and percent complete. If needed, the user can Assign Tasks to specific people. Additionally, 
basic email options are available including recurrence, reminders, categories, and forwarding. 

Creating Tasks can be done two ways. First, new Tasks can be created from scratch by clicking on the Task Pane which 
has the clipboard icon in the lower-left corner of the window. Pressing Ctrl+4 will also work. In this view, a user can 
see all current tasks and create new tasks. New Tasks can also be created at any time by pressing Ctrl+Shift+K.
Second, a new task can be created directly from an email or calendar invite. Select the item then click on the Follow 
Up button, in the Home tab of the Ribbon or right-clicking on the item. A variety of options for when the Task is due 
are available. The Custom option will quickly enable the user to set a specific start date, due date, and reminder. 
A To-Do list can be displayed in the Inbox similar to the calendar on the right-hand side of the window. Click on the To-
Do Bar dropdown in the View tab of the ribbon and select Tasks. The user’s tasks will be listed by due date and can be 
checked off or edited. 

Outlook’s Color Categories

In Outlook, you can use Categories to organize your emails. When you select an email, there is a Categorize dropdown 
option in the Home tab of the ribbon. Categories are basically a color coding system that you can apply to your emails. 
In the Tags section of the Home tab click on the Categories icon. Click on “All Categories”. This will open the “Color 
Categories” window where you can create and edit categories. After you have setup the categories, you can right-click 
on the box when you select an email and it will bring up a list of categories that you can apply to the email. 
Alternatively, you can use

Ctrl+F2 through Ctrl+F12 as a shortcut if you assigned it when you created or edited the category. This is a very useful 
way to visually organize your emails.

Outlook Conditional Formatting

Some users may not like do not like the low contrast between read/unread messages and the large font size which are 
the defaults in Outlook mailboxes. Outlook does provide a Conditional Formatting feature enabling the user to setup 
specific formatting. The formatting can be applied to emails based on a variety of criteria such as being read or 
unread. 

To access the Conditional Formatting options, click on the View tab in the ribbon and select the View Settings button 
(i.e., two gears icon). This will open the Advanced View Settings window. Click on the Conditional Formatting button. 
In the Conditional Formatting window, a list of “Rules for this view”. Detailed instructions with examples can be found 
here. 

A final note on conditional formatting in Outlook: Similar to how conditional formatting in excel can only be applied to 
a single sheet at a time. Outlooks conditional formatting rules will only apply to the mailbox you are viewing when you 
open the View Settings. This means that you would have to apply these rules individually to your Inbox, Sent Items, 
Deleted Items, archive folders, etc.
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EXECUTIVE BOARD MEETING MINUTES 
ASMC – Aviation Chapter 

Executive Board Meeting Minutes 
23 April 2021 (1300-1400)

CVR Teams Meeting 
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I. Call to Order - President:

II. Attendance/Reports

Treasurers: Rebecca Workman, Dawn O’Connell 
Secretary: Susan Duening 
President-Elect: Beth Jankowski (A) 
Vice-Presidents 
AFAA: Heather Brodess (A)
AFLCMC: Dawn Holding (A)
AFMC:  Terri Desch (A)
AFRL: Kristen Wentworth (A)
At Large: Amy Williams 
Contractors: Patrice Solorzano (A)*Ask Rhonda send new membership list (for all)
88th CPTS: Shannon Noles (A)

     Committee Chairs:

Audit: Stephanie Burd, Michelle Hatton 
Augsburg Scholarship: JoAnne Wills 
Awards and Recognition: Vacant
Chapter Competition: JR Frazier 
Communications: Colleen Robinson (A)  
Community Activities: Rhonda Pepitone 
Health & Wellness: Fernando Mason (A)
Membership: Rhonda Pepitone, Cynthia Payne 
Professional Development: Vacant
Programs: Tammy Pendergast (A)
Ways & Mean: Vacant 
(A) = In Attendance

III. General Business:
A. OLD:
B. Open positions: Secretary, Professional Development, Awards, Ways and Means, Community Activities

1. Rhonda Pepitone has volunteered to take over the Membership Committee.
2. Verify current chairs will return for next year.
3. Pres-Elect Beth stated she’d like early careerists to assist with positions for next year.

C. Open Co-Chairs: Programs Committee
D. VPs up for election this year: AFAA, AFLCMC, and Contractor VPs.  AFMC and 88th CPTS VPs also 
indicated they would need replaced at the end of this year (June).  For the 
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organizations needing new VPs, the current VPs needs to request nominations and then hold a vote.  
Established suspense for new VPs (15 June).  All new officers should be inducted during the June Meeting. 
iv. Chapter coins:  Need to order a minimum of 100.  (Heather will work on this!)
v. National & Local Annual Awards:

1. We have awards to present for last year and current year – if any of the VPs are able to present to the
award winners in their organization, please let Sheena know.

2. Based on the discussion during last month’s meeting, and the subsequent Board vote (via email) we
awarded one award per category.

vi. Mini-PDI.  Next Wednesday-Thursday!
vii. Fundraisers:  We did not submit a letter of intent to work the vendor booths for the 2021 Air Show.
Potential: Dayton Dragons.
viii. Future socials – virtual social (i.e. via Zoom) to help get more people involved in the chapter.

B. NEW:

i. Potential virtual meetings – upper management lead topic to have discussions (10-15 people)
1. Have people submit topics.

ii. Next member meetings:
1. May – TBD
2. June – TBD
3. Future speakers: Lt Col Wolfram (June?), Kearney & Co.
4. Please let Tammy Pendergast know about any potential speakers.

iii. Adjourned at 1339.



ASMC's CDFM

We are excited to announce that ASMC is offering CDFM Module's 1-3 the week before PDI, and registration is now open.

Take a deep dive into the core areas of Defense Financial Management with ASMC’s Certified Defense Financial 
Management (CDFM) Refresher courses!

Each CDFM Refresher course provides intensive instruction focused on the material covered in one of the three modules of 
the Enhanced Defense Financial Management Training Course (EDFMTC). Although there are no prerequisites, the course is 
intended for those who have completed a significant amount of exam preparation and wish to “top off” or refresh their 
knowledge prior to taking a CDFM exam. The CDFM Refresher Courses are currently being held in a Virtual setting.

The CDFM Refresher Courses are currently being held in a Virtual setting. These are LIVE, Instructor-Led Training hosted via 
the Zoom platform (not on the PDI platform). Choose the module for which you need a refresher or register for all three 
modules prior to taking your CDFM exams. Note that registration is limited to the first 40 attendees for each Module.

Dates: May 24-26

May 24:CDFM Module 1-(1 Day)-Resource MGMT Environment: 0800 ET
May 25: CDFM Module 2-(1 Day)-Budget & Cost Analysis: 0800 ET
May 26: CDFM Module 3-(1 Day)-Accounting & Finance: 0800 ET

Each Module is $250.00 each (does not include a text book or exam)

https://imis.asmconline.org/net/Products.aspx?category=refresher

Celebrating 20 Years Strong!
The Certified Defense Financial Manager certification program turned 20 this year! Help us congratulate and celebrate those 
who have earned a CDFM or CDFM-A. They have demonstrated a commitment to excellence in defense financial 
management and joined an elite group of highly qualified professionals.

The CDFM is the Sign of Distinction in Defense Financial Management!

CDFM Program Background
The CDFM is a professional, assessment-based certification originally developed by ASMC in partnership with the 
Department of Defense and the Chauncey Group, a wholly owned subsidiary of the Educational Testing Service. The CDFM 
exams went live in the year 2000. The CDFM Program is governed by the ASMC Certification Commission, and the ASMC 
Certification Department runs the day-to-day operations.*

OUSD-C Now Accepts the CDFM as an Alternative to DFMCP Certification

In January 2021, the Office of the Under Secretary of Defense released a Policy Memorandum announcing the CDFM™ as 
one of five professional certifications that can serve as an “Alternative Professional Certification” to any of the three DFMCP 
certification levels. This exception to policy means you can now “present and maintain” the CDFM to meet any of the three 
DFMCP certification levels—earning the CDFM gives you a transferable, test-based credential that can be used anywhere in 
Federal service or the private sector!

ASMC NATIONAL PROGRAM NEWS
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Ms. Sheena Fast
Ms. Beth Jankowski - AFMC
Ms. Susan Duening
Ms. Rebecca Workman; Ms. Dawn O’Connell 

Organizational Vice Presidents 
Ms. Shannon Noles 

Ms. Heather Brodess
Ms. Terri Desch 

Ms. Kristen Wentworth

Ms. Dawn Holding
Ms. Amy Williams 

Ms. Patrice Solorzano

Commi ee Chairs 

President 
President‐Elect 

Secretary 
Treasurers 

88th CPTS VP 
AFAA VP 
HQ AFMC VP 
AFRL VP 
AFLCMC VP 
At Large VP    
Contractor VP 

Audit 
Augsburg Scholarship 
Awards and Recognitioǹ 
Chapter Compe on 

Communications
     Adver sing/Publicity 
     Newsle er Editor 

     Photographer 
     Webmaster 
Community Ac vi es 
Health & Wellness 
Membership 
Professional Development 

Programs 
     Tickets 
Ways & Means 

     Early Careerist 

Ms. Stephanie Burd; Ms. Michelle Hatton 
Ms. JoAnne Wills 

Vacant 
Mr. Clarence (JR) Frazier 

Ms. Colleen Robinson 

Ms. Anita Kerns 

Ms. Colleen Robinson

Ms. Tracey Hearns 
Mr. Jonathan Paden 

Ms. Rhonda Pepitone
Mr. Fernando Mason 

Ms. Cynthia Payne; Rhonda Pepitone
Vacant
Ms. Saundra Moncree 

Ms. Tammy Pendergast

Ms. Elaine Norsworthy 
Vacant
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